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4 Preparing Raster 
Images

Whether you acquire an image from a scanner, a digital camera, a royalty-
free CD with 1,000,000 images, or a stock photography vendor, it’s made out 
of pixels. Pixel is shorthand for picture element, the smallest unit of informa-
tion in a digitized image. Even though pictures on your monitor look like 
smooth transitions of color, zoom in sufficiently and you’ll see all the little 
square pixels that actually make up the image (Figure 4.1). While pixels 
make it possible to do much of what we do in the graphic arts, they’re also 
the cause of some important limitations.

Figure 4.1  Images are 
made of pixels. Think of 
them as tiny mosaic tiles.Sam
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Chapter 4: Preparing R aster Images100

Ancient Times: B.P. (Before Pixels)
In the olden days of graphic arts, enormous cameras were used to photo-
graph artwork such as drawings, reflective photographic prints, transpar-
encies, and painted illustrations. Highly skilled specialists commandeered 
these monstrosities, some of which occupied entire rooms (the cameras, not 
the specialists). The use of colored filters, masking, and exposure methods to 
produce color separations (a separate piece of film for each printing ink) was 
rather arcane and required years of apprenticeship and study to perfect. And 
since every step required the use of specialized film, there were a lot of trips 
to a darkroom to develop the results in chemical baths. It all seemed very 
high-tech at the time (well, compared to cave paintings), but the process was 
quite time-consuming.

All About Pixels
Film has given way to pixels, and we have gone from dog-eared color photo-
graphic prints and moldy 35mm slides to storing our family photos on piles 
of CDs, and now into the nebulous world of cloud storage. What was once 
the province of the darkroom became a daylight venture, and the tools of 
the craftsmen became available to anyone brave enough to wade in.

Scanners
While early scanners still required highly skilled graphic arts professionals to 
operate them, they greatly sped up the process of capturing artwork for color 
separations. Early analog models used photomultiplier tubes and a daunting 
array of knobs and buttons to perform the same job that had been done by 
the huge cameras. The first scanners were petite only by comparison to their 
gigantic camera ancestors: Many could easily dwarf a Volkswagen. It was nec-
essary to mount artwork on a heavy, clear plastic drum and then painstak-
ingly ensure that there was no dust or a trapped air bubble to mar the scan. 
Scanner operators came from the ranks of color-separation cameramen, and 
their years of finely honed instincts for camera separations translated well to 
the newer methods. Thus began the move to digital capture and storage of 
image information, resulting in our devotion to the pixel and the advent  
of digital retouching.
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All About Pixels 101

In the mid-1990s, improvements in the capabilities and simplicity of flatbed 
scanners, coupled with the widespread usage of Adobe Photoshop, led to a 
major change in the way color separations were performed. It was no longer 
necessary to mount artwork on cylindrical drums, and the numerous knobs 
were replaced with onscreen buttons and dialog boxes. The digital imaging 
revolution was underway. Suddenly, people who weren’t sure what color 
separation meant were making color separations.

As flatbed scanners have become more automated and less expensive,  
it’s relatively easy even for novices to make a decent scan. But the more you 
know about what constitutes a good image, the better the chance you can 
create a great image from the pixels generated by your scanner.

Digital Cameras
Today’s scanners capture transparencies, negative film, paintings, and 
illustrations and express them as pixels. High-end digital cameras now 
rival — or exceed — the ability of film-based cameras to capture photo-
graphic detail. The image captured by the camera is a digital original, so 
there’s no need to scan a print. Of course, the better the camera and the 
photographer, the better the image. The rapid evolution of digital image 
capture is such that today’s cellphones take pictures with more inherent 
information than the earliest digital cameras. 

While conventional camera film — such as 35mm transparencies — must be 
scanned to be used on your computer, digital camera images can be down-
loaded directly to the computer and used immediately. Digital photography 
also cuts out the middleman. Unlike film images, digital images don’t have 
any grain, although an image photographed in low lighting conditions 
may tax the resolving capabilities of a digital camera’s sensor, resulting in 
unwanted digital noise. 

Consumer point-and-shoot cameras deliver captured images as JPEG,  
a compressed format. There are degrees of compression, from gentle to 
aggressive, and you may never notice any visible artifacts betraying the 
compression. But higher level “prosumer” cameras and professional digital 
cameras can deliver images in the Camera Raw format, which is subjected 
to minimal processing by the camera. While you cannot place a Raw file 
directly into Illustrator or InDesign, Raw images can be opened directly  
in Photoshop and saved in another format, such as Photoshop PSD. 

TIP  While you can’t 
place a Camera Raw 

file directly into Illustrator or 
InDesign, there is a work-
around. In the Camera Raw 
module within Photoshop, hold 
down Shift as you click Open 
(the Open Image button 
changes to an Open Object 
button): this will open the 
image as a Smart Object in 
Photoshop. Save the image as 
a PSD, and you can then place 
it in Illustrator or InDesign  
while retaining the secret 
Camera Raw editing ability. 
Back in Photoshop, just double-
click the Smart Object to edit in 
Camera Raw. 
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Chapter 4: Preparing R aster Images102

Raw files can be color corrected in the Photoshop Camera Raw environment 
without losing additional information. For example, an image shot under 
daylight conditions but with the camera’s white balance set to fluorescent 
lighting can be corrected with one click in the Camera Raw environment 
without the loss of information that would be incurred by using a Levels or 
Curves correction in Photoshop.

If you are a point-and-shoot photographer who just wants to capture 
moments from a quick vacation, you may consider Raw files to be overkill. 
But for professional photographers, Camera Raw is a powerful and flexible 
format, often enabling the recovery or enhancement of details and tones 
that would be lost in a JPEG file.

Imaging Software
Once you have captured pixels, it’s likely that you’ll feel compelled to modify 
them. The industry standard imaging application is Adobe Photoshop, and 
for good reason. Photoshop provides controls for color correction that enable 
a knowledgeable user to achieve results equal to those of a knob-twisting 
scanner operator. Its tools surpass the capabilities of the original, million-
dollar dedicated systems. If you’re just beginning to learn Photoshop, you 
won’t lack for educational resources. You could probably build an addition 
to your house from the books devoted to exploring Photoshop. You can add 
Chapter 10, “Photoshop Production Tips,” to the pile.

Photoshop is arguably the most versatile and widely accepted application 
for image manipulation, but there are other applications that perform use-
ful imaging functions as well.

Adobe Photoshop Elements® (Mac/PC) might be regarded as “Photoshop 
Lite,” but it still packs a hefty arsenal of retouching and color-correction 
tools. The product is geared toward enthusiasts and lacks support for  
CMYK images.

Adobe Lightroom™ (Mac/PC)  is engineered for use by photographers and 
provides sophisticated tools for organizing and color correcting images.

Apple iPhoto® (Mac only) is geared toward hobbyists, with organizational 
tools and limited color-correction capabilities. However, it offers no support 
for CMYK images. 
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Resolution and Image Fidelity 103

Aperture (Mac only) is targeted to photographers and includes support for 
Camera Raw files. It provides organizational tools as well as color-correction 
controls but provides no support for CMYK images.

These are not the only solutions that exist for manipulating images. There 
are painting programs, such as Painter™ and Paint Shop Pro® (both from 
Corel®), which let you easily make images resemble watercolors or oil paint-
ings. Imaging tools for consumer and hobbyist photographers increase on a 
daily basis. However, most of these programs don’t offer support for CMYK 
images, so they’re not the best tools if you’re preparing images for print.

Let’s face it—if you’re designing for print, you can’t live without Photoshop. 
When the name of a product becomes a verb — “Please Photoshop that out”—
it’s a sure sign that the product has become the industry standard.

Resolution and Image Fidelity
The resolution of an image is generally measured in pixels per inch (ppi) 
unless you speak metric, in which case it’s expressed in pixels per millimeter. 
Determining the proper resolution for Web images is simple: 72 ppi at final 
size. But there are strongly held (and hotly debated) beliefs regarding the 
appropriate image resolution for printing. Some hold that 150 percent of the 
final screen ruling value is sufficient, and some believe twice the final ruling 
is preferable, largely because it’s easier to calculate the resolution. For exam-
ple, an image that will be printed at 150 line screen should have a resolution 
of 300 ppi. In the past, when typical hard drives held 80 MB, networks were 
glacially slow, and RIPs choked on 15 MB PostScript files, it was important to 
trim off every little bit of fat, so we agonized over resolution. But now, with 
hard drives measured in hundreds of gigabytes, and RIPs with much more 
robust digestive tracts, we can afford the luxury of a few extra pixels. That 
said, there’s rarely an advantage to exceeding 300 ppi, except in some cases 
for higher line screens such as 175 lpi printing. So put away the calculator. 
For most circumstances, 300 ppi at final size is adequate and provides a bit of 
elbow room if you have to slightly reduce or enlarge an image.

But you do have some leeway, depending on the nature of the image and  
how it will be used. For example, a gauzy, soft-focus shot of a sunset that  
will be used as a ghosted background accent in a magazine can be used at 
200 ppi with no problem. A highly detailed close-up image of an important  
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Chapter 4: Preparing R aster Images104

piece of antique jewelry in a 175 lpi art book should be at 300–350 ppi. At  
the other end of the spectrum, an image for use in an 85 lpi newspaper can 
be 130–170 ppi, because much of the information in a 300 ppi image would be 
lost when printed in the coarse newspaper screen ruling. Consider the deter-
mination of appropriate resolution to be an equation based on image content 
and the final printing line screen rather than an absolute number.

Scaling Up
When enlarging or reducing an image, don’t be afraid to slightly reduce or 
enlarge an image. But be aware that when an image is scanned or captured 
by a digital camera, it contains a fixed number of pixels. When you enlarge 
an image, you’re attempting to generate missing information in a process 
called interpolation; the result is never as good as a proper-sized original 
scan. And the more drastic the transformation, the less satisfying the out-
come (Figure 4.2).

A B

DC

Figure 4.2  You can’t  
truly make something from 
nothing. Notice the loss of 
detail in the scaled-up  
version (D) versus the  
original (A).
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Resolution and Image Fidelity 105

Because of the limitations imposed by resolution, it’s helpful if you can 
anticipate how the image will be used and control photography or scanning 
accordingly. For typical image content, you can probably scale up to 120–125 
percent. If the image is background content without much detail, such as 
a soft-focus landscape, you have more leeway and can probably get away 
with scaling up to 150–200 percent. Conversely, if you need to maintain very 
small details, you may be limited to a maximum of 120 percent. 

Photoshop CC introduced a new method that does a better job of scaling up 
images and upsampling them to higher resolutions—Preserve Details. While 
the results won’t be equal to a higher resolution original image, it’s a definite 
improvement over earlier methods (Figure 4.3).

Scaling Down
Scaling down an image also involves interpolation. While the loss of data 
may not be quite so obvious when you reduce the size of an image, there can 
be some softening of detail. For best results, choose the Automatic option in 
the Image Size dialog box in Photoshop CC; it applies some sharpening to 
camouflage the reduction in detail. While it’s acceptable to scale images in 
InDesign, if you find it necessary to scale an image below 75 percent of its 
original size in your page layout, consider scaling it down in Photoshop CC 
instead, because InDesign can’t sharpen image content.

Figure 4.3  If you have 
to scale up an image, or 
artificially increase its resolu-
tion, be sure to choose the 
Preserve Details option in 
the Photoshop CC Image Size 
dialog box. Tip: If you select 
“Automatic,” Photoshop CC 
chooses the best method for 
resampling.
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Scanning Artwork
If you are incorporating flat artwork such as pen-and-ink drawings or paint-
ings in your design, you have several choices for digitizing the artwork. If 
you have a good flatbed scanner, you may be able to capture the artwork 
without any special handling. To provide some flexibility in later usages of 
the scanned image, consider performing two scans at 100 percent: one at 
300 ppi, and one at 600 ppi if your scanner supports it. Then, you have two 
robust images that can be resized for a wider range of uses.

If your flatbed scanner isn’t up to the task, ask if your print service provider 
performs scanning. Many printers have high-end scanners capable of cap-
turing and enlarging artwork. If you have transparencies or negative film 
that must be scanned, the printer’s professional scanners can capture detail 
and perform enlargements with higher-quality results than are possible 
with consumer-level scanners.

Some materials, such as textured paper, dimensional paint (such as heavy 
acrylic or oil paint), metal, or transparent substrates, don’t scan well. The 
scanner’s illumination bounces off metallic components and often appears 
black in the scanned image. Because of the even, frontal lighting of the scan-
ner, texture is subdued or lost. And you can’t very well pin a statue under 
the lid of your scanner. If you have to capture a challenging art piece, the 
best solution might be to hire a photographer who specializes in capturing 
fine art pieces and has experience lighting and photographing such projects.

Cropping and Transforming Images
It would be great if you could anticipate the exact size, crop, and angle at 
which you’ll want to use an image in your page layout. But it may be difficult 
to see that far down the line at the moment you’re pressing the button on 
your camera, or slipping a print under the lid of your flatbed scanner. Oh, 
and watch out for that little gust of wind that comes along just as you’re put-
ting the scanner lid down…
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Cropping and Transforming Images 107

Cropping

Should you crop your images? Maybe. If you’re certain about future image 
use, feel free to crop. Leave a reasonable rind around the image area you 
intend to use to provide some elbow room when you place the image in the 
final page, so you have room to reposition the image, or to provide bleed 
for the page. However, if you think there’s even a remote chance that you’ll 
want to use more of the image in the near future — maybe you’re not sure 
if you might want to show a row of four buildings instead of just the one in 
the middle — then it’s worth keeping the whole shebang. While you may be 
reluctant to store an entire image just to keep the part with the 2-inch golf 
ball that you’re sure you will silhouette, give yourself a safety net and at least 
keep an uncropped backup copy of the image. Hard drive space is plentiful 
and you can always crop it later. It’s hard to recover that extra person you 
lopped off last week who turns out to be the CEO of the company.

Rotating Images

Almost any transformation, whether resizing or rotating, causes interpo-
lation of pixel information. The only safe rotations are 90-degree incre-
ments—anything else will result in softening of detail (see Figure 4.4). Think 
of those rows and columns of pixels, much like the grid of a needlepoint 
pattern. Imagine what a challenge it would be to redraw that pattern at a 
42-degree angle. It should give you a little sympathy for the math Photoshop 
has to do.

Figure 4.4  Repeated rota-
tions of an image can result in 
cumulative erosion of detail 
(original image on the left, 
rotated image on the right). 
The exaggerated sharpening 
in the image on the right is a 
result of Photoshop’s attempt 
to compensate for softening 
of detail.
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Chapter 4: Preparing R aster Images108

All these cautions about transformations such as scaling and rotating are not 
intended to strike terror in your heart. Don’t be afraid to enlarge, reduce, or 
rotate if you need to. Just be prepared for the slight but unavoidable loss of 
detail and the degradation of the image’s appearance. Try to resize in even 
increments, and beware of oddball rotations such as 1.25 degrees in the 
interest of maintaining as much information as possible.

Successive transformations—scaling and then rotating, for example—are 
particularly destructive. Let your conscience be your guide. How important 
is the detail in the image? If it’s a key product shot, it’s worth rescanning (if 
possible). If it’s a less important image, such as a ghosted background or a 
decorative bit, you needn’t feel quite so guilty about the transformation.

Where to Transform: Image Editor vs. Page-Layout Application

If you are going to transform images, does it matter where the transforma-
tion takes place? If you use Photoshop to scale an image, is the result superior 
to the outcome of scaling within your page-layout application?

The answer is an unqualified, “It depends.”

If you perform your scaling and rotation in Photoshop or another image-
editing application, and then place the resulting image in a page layout at 
100 percent with no rotation, you do have a pretty good idea of how the 
image will look when it’s printed.

If, however, you induce the scaling or rotation in a page layout, you’ve only 
requested those transformations—you haven’t actually performed the transfor-
mations. They don’t really take place until the job is processed by a RIP. This 
puts you at the mercy of that RIP’s implementation of scaling and rotation 
algorithms. If you generate and submit PDFs, the rotations or distortions 
within that PDF are still pending, and they are implemented only when the 
PDF is processed by a RIP. In other words, the original image information is 
contained in the PDF, unchanged, but earmarked for its ultimate transfor-
mation in the RIP.

Be comforted by the fact that late-model RIPs can chew a lot more infor-
mation in a shorter time than they used to. Rotating a few images here 
and there won’t prevent the processing of your job. However, despite the 
improvements in RIP technology, it is still possible (although rare) to build 
a job that can’t be processed by a RIP. (Please don’t take that remark as a 
personal challenge.)
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Appropriate Image Formats for Print 109

Keep in mind, too, that if you’ve rotated an image in Photoshop and then 
subsequently applied additional scaling or rotation in a page layout, you’ve 
transformed it twice. It’s not the end of the world, but you may see some 
slight softening of detail in the finished piece.

Appropriate Image Formats for Print
How you should save your raster images is governed largely by how you 
intend to use them. Often, you will be placing images into InDesign or 
Illustrator, so you’re limited to the formats supported by those applications. 
The application may be willing to let you place a wide variety of file formats, 
but that doesn’t necessarily serve as an endorsement of file format wonder-
fulness. In the olden days, the most commonly used image formats were 
TIFF and EPS. However, native Photoshop files (PSD) and Photoshop PDF files 
are much more flexible, and both formats are supported by InDesign and 
Illustrator. So, there’s not much reason to use other formats unless you’re 
handing off your images to users of other applications, such as Microsoft 
PowerPoint or Word.

TIFF
If you need to blindly send an image out into the world, TIFF (tagged image 
file format) is one of the most widely supported image file formats. It’s happy 
being imported into Illustrator, InDesign, Microsoft Word, and even some 
text editors—almost any application that accepts images. The TIFF image 
format supports multiple layers as well as RGB and CMYK color spaces, and 
even allows an image to contain spot-color channels (although some applica-
tions, such as Word, do not support such nontraditional contents in a TIFF).

Photoshop EPS
Some equate the acronym EPS (Encapsulated PostScript) with vector artwork, 
but the encapsulated part of the format’s name gives a hint about the flexibil-
ity of the format. It’s a container for artwork, and it can transport vector art, 
raster images, or a combination of raster and vector content. EPS is, as the 
name implies, PostScript in a bag (see the sidebar, “EPS: Raster or Vector?”). 
The historic reasons for saving an image as a Photoshop EPS were to preserve 

NOTE  When you 
receive a JPEG image, 

it’s a good idea to immediately 
resave it as a PSD or TIFF to 
avoid further erosion to image 
content. Repeatedly opening, 
modifying, and resaving a JPEG 
can result in compromised 
quality if aggressive compres-
sion is used.
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Chapter 4: Preparing R aster Images110

the special function of a PostScript-based vector clipping path used to silhou-
ette an image or to preserve an image set up to image as a duotone. If you’re 
using InDesign and Illustrator, that’s no longer necessary.

EPS: Raster or Vector?

It may be a bit confusing that there are raster-based EPSs (saved from an 
image-editing program such as Photoshop) and vector-based EPSs (saved 
from a vector drawing program such as Adobe Illustrator or Adobe [formerly 
Macromedia] FreeHand). The uninitiated sometimes think that saving an 
image as an EPS magically vectorizes it. Not so. Think of the EPS format as a 
type of container. The pixels within an EPS are no different from those in their 
TIFF brethren. They’re just contained and presented in a different way.

As applications and RIPs have progressed, you’re no longer required to save 
such images as Photoshop EPS. Pixel for pixel, a Photoshop native PSD is a 
smaller file than an equivalent EPS and offers support for clipping paths as 
well as duotone definitions.

This doesn’t mean you need to hunt down your legacy Photoshop EPS files 
and resave them as PSD (unless you’re terribly bored). Just know that unless 
you need to accommodate someone else’s requirements, there’s no advantage 
to saving as Photoshop EPS now.

Photoshop Native (PSD)
In ancient times, the native PSD (Photoshop document) format was used 
solely for working files in Photoshop. Copies of those working files were 
flattened and saved in TIFF or EPS formats for placement in a page-layout 
program. While PageMaker allowed placement of native Photoshop files (yes, 
really — although it did not honor transparency), QuarkXPress required TIFF 
or EPS instead. Old habits die hard, and TIFF and EPS have long been the 
standard of the industry. Not that there’s anything truly wrong with that.

However, Illustrator and InDesign can take advantage of the layers and trans-
parency in Photoshop native files, eliminating the need to go back through 
two generations of an image to make corrections to an original file. Today, 

Transparency TIP: 
Although Illustrator and 

InDesign accept and correctly 
handle opacity settings in a 
placed native Photoshop file, 
they do not correctly handle 
blending modes in a Photo-
shop file. There are some work-
arounds for InDesign, detailed 
in Chapter 12, “InDesign  
Production Tips.” 
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there’s no need to maintain two separate images: the working image and the 
finished file are now the same file. 

Photoshop PDF
A Photoshop PDF (Portable Document Format) contains the same pixels as 
a garden-variety PSD, but those pixels are encased in a PDF wrapper—it’s 
like the chocolate-covered cherry of file formats. A Photoshop PDF comes in 
handy on special occasions, because it can contain vector and type elements 
without rasterizing the vector content, and it allows nondestructive round-
trip editing in Photoshop. 

A Photoshop EPS can contain vectors and text, but the vector content will 
be converted to pixels if the file is reopened in Photoshop, losing the crisp 
vector edge—so you lose the ability to edit text or vector content. A native 
Photoshop PSD can contain vector components, but page-layout programs 
rasterize the content. However, Photoshop PDFs preserve vector content 
when placed in other applications (see Table 4.1 for a feature comparison  
of common image formats). 

Table 4.1  Image format features

Supported Feature TIFF EPS PSD JPEG PDF

RGB color space X X X X X

CMYK color space X X X X X

Grayscale X X X X X

ICC profiles X X X X X

Clipping paths X X X X X

Layers X — X — X

Alpha channels X — X — X

Spot color channels X 1 X — X

Duotones — X X — X

Bitmap (bi-level content) X X X — X

Vector data — 2 3 — X

Transparency X — X — X

1 If saved as DCS 2.0 (a variant of the EPS format)
2 EPSs cannot be reopened in Photoshop with vector content intact
3 Page-layout applications rasterize vector content in PSDs
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Moving to Native PSD and PDF
Is there any compelling reason to continue using old-fashioned TIFFs and 
EPSs? It may seem adventurous to use such new-fangled files, but workflow 
is changing. The demarcation between photo-compositing and page layout 
is blurring, and designers demand more power and flexibility from soft-
ware. RIPs are more robust than ever, networks are faster, and hard drives 
are huge. It’s still important to know the imaging challenges posed by using 
native files (such as transparency), and it’s wise to communicate with your 
printer before you embark on the all-native path. You’re still at the mercy of 
the equipment and processes used by the printer, and if they’re lagging a bit 
behind the latest software and hardware developments, you may be limited 
by their capabilities. 

Bitmap Images
Also called “line art images,” bitmap images contain only black and white 
pixels, with no intermediate shades of gray. If you need to scan a signature 
to add to an editorial page or scan a pen and ink sketch, a bitmap scan can 
provide a sharp, clean image. Because of the compact nature of bitmap 
scans, they can be very high resolution (usually 600–1200 ppi) but still pro-
duce small file sizes (Figure 4.5).

Special Case: Screen Captures
If you’re creating software documentation for print, or you want to show 
an image of a Web page in your project, you may need to include screen 
captures of software interface components such as menus or panels in your 
page layouts. Screen captures are easy to make using a system utility or dedi-
cated screen-capture software, but they require some special handling to 
print clearly. When they’re part of software documentation or instructional 
materials, it’s important that the details are as sharply rendered as possible.

Figure 4.5  This 1200 ppi 
bitmap scan prints nearly 
as sharply as vector art. It 
weighs in at less than 1 MB;  
a grayscale image of this 
size and resolution would be 
nearly 10 MB. Magnified to 
300 percent, it may look a bit 
rough, but at 100 percent it’s 
crisp and clean.
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You should understand this about screen captures: Whether you take them 
by using your system’s built-in screen-capture functionality or a third-party 
screen-capture application, you are merely intercepting information that 
eventually becomes pixels on your monitor. Regardless of your current 
monitor resolution, there is a one-to-one relationship between the fixed 
number of pixels that an application (and your system) uses to render panels 
and menus and the number of pixels you see on your screen, even if you use 
a zoom utility. Of course, the size of the overall image you see is a function 
of your current monitor resolution, but the pixel dimensions of panels, menus, 
and tools will be identical, regardless of resolution. (Figure 4.6)

An application panel that measures 244 pixels by 117 pixels appears larger 
when your screen resolution is set to 800 by 600, and it’s almost unreadably 
small when your monitor is set to 1920 by 1200. However, the panel is made 
of exactly the same number of pixels in both instances. So it doesn’t matter 
what resolution your monitor is using, or how large the panels may appear 
onscreen, or whether you use a utility to zoom in. The captured image of a 
panel or menu will be the same in terms of pixel dimensions, regardless of 
the monitor resolution setting, and the resulting image will be 72 ppi.

Monitor Resolution 
800x600

244 x 117 pixels, 72 ppi

Monitor Resolution 
1360x768

244 x 117 pixels, 72 ppi

Monitor Resolution
1920x1200

244 x 117 pixels, 72 ppi

Monitor Resolution
1920x1200, zoomed using OS X  

Accessibility Zoom feature
244 x 117 pixels, 72 ppi

Figure 4.6  The resolution 
setting of your monitor has 
no effect on the number of 
pixels used by panels and 
menus. Although this panel 
was captured at three differ-
ent monitor resolutions, the 
three captures are identical, 
each consisting of exactly the 
same number of pixels.

TIP  Do an experiment: 
In the software of your 

choice, open a panel and posi-
tion it in the middle of the 
screen. Take screen shots at 
two different resolutions. Make 
a loose selection of the panel in 
one image, copy it, and place it 
into the other image. You’ll see 
that they’re identical in pixel 
count. The overall images will 
be different sizes because of the 
different monitor resolutions, 
but the number of pixels used 
by interface components such 
as panels, menus, and tools will 
be identical.
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Since it’s been drilled into you that 300 ppi is the Holy Grail of image reso-
lution, it’s tempting to try to improve screen captures by increasing the 
resolution. Unfortunately, this usually makes them look worse by softening 
small details during interpolation.

If you plan to use a screen capture at 100 percent enlargement, just leave it 
at 72 ppi (go ahead and freak out). Yes, the print service provider’s prepress 
department will raise a flag, but the examples below show why screen cap-
tures are not improved by increasing their resolution.

As you can see in Figure 4.7, the original 72 ppi screen capture seems a bit 
coarse, but it’s readable. Increasing the resolution to 300 ppi in Photoshop may 
sound like a good idea, but the interpolation will soften detail in the image.

A B C

Figure 4.7  Image A is the original 72 
ppi screen shot. Image B is the result of 
increasing the resolution to 300 ppi, 
using the default Bicubic method: Note 
blurry text and softened edges. Image C 
is the result of increasing the resolution 
to 288 ppi, using Nearest Neighbor. 
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If you do feel compelled to increase the resolution of a screen capture, 
choose Image > Image Size in Photoshop, and then set the resolution to an 
even multiple of the original resolution; for example, resample a 72 ppi 
screen shot to 288 ppi. In that same dialog box, set the Resample Image 
option to Nearest Neighbor. This avoids interpolation by simply repeat-
ing pixels rather than attempting to create pixels. It’s not an appropriate 
approach when scaling images of a photographic nature, but it’s a helpful 
solution for screen captures, because of their special nature.

Converting Screen Captures to CMYK

Because screen captures are generated as RGB images, they must usually be 
converted to CMYK for print. When performing that conversion, a special 
approach is recommended to maintain the best rendering of black type. The 
default conversion of RGB to CMYK in Photoshop will render black as a four-
color mix (Figure 4.8), with the possibility that slight misregistration on 
press will turn tiny details to mush.

CYAN MAGENTA

YELLOW BLACK

To simplify printing of screen captures, use a color-separation recipe that 
ensures that all neutral black or gray areas of the image will print only in 
black ink during the RGB-to-CMYK conversion. Neutral areas in an RGB 
image are those areas in which the RGB values are equal; for example, 
R128–G128–B128 would constitute a midtone gray. 

Figure 4.8  A conventional 
conversion from RGB to 
CMYK produces four-color 
equivalents of the gray and 
black parts of a screen cap-
ture. Press misregistration will 
turn text and other black or 
gray elements to an out-of-
focus rainbow. Festive, but 
hard to read.Sam
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To create this custom screen-capture conversion recipe in Photoshop, choose 
Edit > Color Settings to access the color-separation controls. Under Working 
Spaces, choose Custom for the CMYK setting (Figure 4.9). 

Figure 4.9  In the 
Color Settings dialog 
box, select Custom 
CMYK from the 
CMYK menu.

In the Custom CMYK dialog box, select Maximum Black Generation 
(Figure 4.10). The curve you see may seem odd, but it merely indicates  
that all equivalent RGB values are being replaced with black. The appear-
ance of color elements won’t be compromised.  

Figure 4.10  In 
the Custom CMYK 
dialog box, select 
the Maximum 
Black Genera-
tion setting. This 
consolidates all 
gray-equivalent 
values to the black 
channel, minimiz-
ing issues with 
registration.
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Color elements will be composed of four colors in the final CMYK image. 
But black and gray elements will be rendered only in black (Figure 4.11). 
While this may look odd, it results in cleaner printing of the screen capture, 
because there aren’t four colors piling up in most of the image.

CYAN MAGENTA

YELLOW BLACK

RGB vs. CMYK
Since the dawn of desktop publishing, it’s been unquestioned that Thou 
Shalt Convert to CMYK. Those who submitted RGB files were considered 
uninformed, even uncivilized.  

The rules are changing, though, because of the increased use of digital print-
ing. Although these devices may use inks or toners named cyan, magenta, yel-
low, and black, those inks and toners have a different pigment makeup than 
the namesake inks used on offset presses, and they have a wider color gamut 
than offset inks. Inkjet devices such as large-format printers utilize additional 
inks such as light cyan, pink, light yellow, orange, and green, further extend-
ing the range of colors that they can print.

This seems like a good time to open a can of multicolored worms. After 
you’ve been told by printers for years that you should convert your images 
to CMYK before submitting, I’m now going to tell you that you might not 
have to do so. That’s because many digital devices happily digest RGB and 
can provide more vibrant output by rendering RGB content. 

Figure 4.11  All the color 
components appear on the 
cyan, magenta, and yellow 
plates. Black and gray areas 
appear only on the black 
plate. This special treatment 
ensures that screen shots 
print cleanly.
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When you convert to CMYK, ranges of colors outside the CMYK gamut are 
remapped to fall within the CMYK printable gamut, and some of your most 
vibrant colors are lost forever. 

If you happen to have some very colorful RGB images (tropical birds would 
do the trick), try this little experiment:

1.	 Open the RGB image in Photoshop, and maybe make it even more 
vibrant by using Hue/Saturation or Vibrance. Get carried away; this  
is for science, after all, not for art.

2.	 Choose Edit > Color Settings. At the top of the dialog box, choose North 
America Prepress 2 from the menu and click OK.

3.	 Choose View > Proof Colors. The difference in appearance may not be 
huge, but try toggling Proof Colors on and off quickly by using the key-
board shortcut (PC: Ctrl-Y; Mac: Cmd-Y) and watch for differences in 
bright blues and greens. Neon greens provide a particularly noticeable 
difference.

4.	 Choose View > Gamut Warning. The gray areas are areas whose current 
RGB color will be remapped (and probably become duller) when con-
verted to CMYK, because of the smaller color gamut of CMYK.

This gives you an idea of the color range that you’ll lose when you convert 
to CMYK—and much of that color range can be imaged on many digital 
devices. Of course, ask the print service provider before you submit your 
work to ensure that you’re sending what they want. Just don’t be surprised 
if they say “RGB is OK.”

RGB as a Working Format

Because the RGB gamut is larger than that of CMYK, it’s often preferable to 
perform color corrections and compositing with RGB files, converting to 
CMYK (if necessary) as late in the process as possible. If you are participat-
ing in a fully color-managed workflow, you will keep your images as RGB 
with ICC profiles. The International Color Consortium (ICC) was formed 
by a group of graphic arts industry vendors, with the goal of promoting the 
use and standardization of color management tools. ICC profiles are meth-
ods of describing the characteristics of devices such as scanners, presses, 
and printers for optimal results. Conversion will not take place until the job 
is imaged. Much of today’s software offers sophisticated support of color 
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